Date updated

First Name Last Name, M.D., Ph.D.
Academic Rank, Department
Director, Center for Whatever
Your medical school or university
Professional Street Address
City, State Zip Code
(Area code) phone number
email@address.com

Education and Training
[Note: in reverse chronological order, year & dates on either left or right]
Fellowship, Your University, City, State	Years/Dates
Residency, Your University, City, State	Years/Dates
M.D., Your University, City, State	Years/Dates
B.S. in Discipline (magna cum laude), Your University, City, State	Years/Dates

Academic, Administrative & Clinical Appointments 
[Note: in reverse chronological order]
Associate Professor	Year/Date - Present
Department of …
Name of University
City, State	

Director, Center for …	Years/Dates
Name of Medical School or University
City, State

Assistant Professor	Years/Dates
Department of ..
Name of University
City, State

[bookmark: _GoBack]Professional Education & Experience
[Note: List non-academic employment and experience in reverse chronological order, Include leadership or professional development activities]


Military Service 
[optional]

Certification and Licensure
Diplomate, Your ABMS Board	Years/Dates
Subspecialty Certification, Your Subspecialty Board	Years/Dates
State Medical License (active and inactive, without numbers)	Years/Dates

Honors and Awards	
[Receipt of competitive scholarships, fellowships, and assistantships; names of scholastic honors, and teaching or research awards. Note: you may also list selective fellowship programs, those to which you were accepted as a competitive, as opposed to first-come, first-serve, application process.]

Research or Clinical Interests
[Note: Insert 3-4 numbered interests]
Interest

Grants and Contracts
[For each grant, on separate lines, include: Funding agency, Title of grant, PI, (Direct/Total cost entire project (optional)), Dates, Role on project)]

Current Grants
Funding agency:
Title of grant:
PI:
Direct/Total cost entire project: (optional)
Dates:
Role on project:

Pending Grants

Past Grants

Submitted not funded Grants
[This section is optional for the CV, but P&T packet has this]

Current Contracts


Pending Contracts


Past Contracts


Submitted Not Funded Contracts


Patents and Technology Transfer
[Include patent pending or patent applications, with dates of filing. List any technologies licensed to industry or others (military, etc.) with dates of licensure or filing]


Professional Memberships
[List these in groupings by professional organization, may note leadership positions and other positions held though typically in later section, include years]


Editorial Positions, Boards, & Peer-Review Services	
[Include relevant dates]
Study Sections


Journal Refereed


Editorial Boards


Program Memberships


Board Memberships

Clinical Activities & Quality Improvement Initiatives
[List clinical responsibilities and other clinical activities that include number of weeks, and percentage/time effort, clinics & procedures can be listed in days or half days]

Clinical Service
Inpatient Service
· 

Outpatient Service
· 

Procedures
· 

Other
· 

Quality Improvement Initiatives


Teaching
[Identify your teaching activities here or write “See attached Teaching Portfolio.”]
[Note: Reflect the years you undertake each activity]
[May want to Categorize educational activities as follows: Educational Administration (Director, Dean, etc.), Training Program Committees, Course and Curriculum Development, Courses Directed, Didactic Sessions, Clinical Teaching, Laboratory Teaching, Small Group Teaching, Graduate Student Committees] 

National/International
[Put national teaching here. You will have to decide which to put here vs. in Visiting Professorships and Extramural Invited Presentations. I put here if it is “teachy”]


Institutional
[Medical Student teaching, Departmental Conferences and Resident teaching, Divisional Conferences and Fellow teaching, College of Medicine Conferences and Teaching, Other Teaching and Lecturing Activities]


Formal Mentorship
[only list those with a significant time investment that are outside of “normal” teaching duties, list project mentored and result. Include mentee name, institution, mentee level/ rank, role, project mentored, next position/accomplishment] – [Residents, Post-Doctoral Fellows, Students, Other Formal Mentorship activities]


Committee, Organizational & Volunteer Services
[List in years in chronological order, noting leadership positions held.  Include university and non-university activities]
National


Institutional


Professional Organizations (Major affiliations)
[Chronological service separated by organization]

Volunteer (Community)
[note if info duplicated elsewhere]
Hobby

Consulting Positions & Pharmaceutical Advisory Boards
[Include dates, location, work performed, organizer/employer]

Visiting Professorships and Extramural Invited Presentations
[Include dates, type, venue]

CME Courses Organized and Directed
[Mention if redundant info]

Interviews, Internet Appearances, Panel Discussions, Media Events
[Mention if redundant info]


Creative Works, Social Media or Internet Projects not included elsewhere
[List CDs, interviews, simulations, films, websites, webinars, case vignettes you authored and are in use, and any other creative work products.  Indicate your role in the creation of the product – creator, author, co-author, webmaster, etc.]

Hobbies and Other activities
[optional but EZ likes this!]

Bibliography
[List your publications in chronological order for easy updating]
[Number these and highlight your name in bold]
[Note in parenthesis articles submitted, accepted for publication (in press), reviews, editorials, conference proceedings, simultaneous publications, development and/or publication]
[Optional: include sections for educational materials, published major curricular offerings, innovative educational programs, and non-print materials]
[If you are not listed as first author on publications for which your mentored student is listed, note that role with an asterisk or other indicator]

Peer-Reviewed Publications
1. 

Non-Peer-Reviewed Publications
1. 

Books
1. 

Chapters in Books
1. 

Abstracts 
[add info on type of presentation, type of meeting, etc. If published give reference, “presented in poster form (vs. oral presentation) at ???, City, State, Date or year”]
[List these in chronological order, may want to use an asterisk or other explained notation to demarcate invited talks and meetings that you helped to organize.]
[This section is for presentations given where you are an author]

Oral Presentations 
· Presentation	Date

National/International Meetings
· Meetings	Date

Local/Regional Meetings
· Meetings	Date

Peer-reviewed Presentations (including Workshops)
· Presentation/Workshop	Date

Poster Presentations

National/International
· Meeting	Date

Local/Regional 
· Meeting	Date




Bibliography Notes for Promotion and Tenure
Publications notations needed for promotion.
Accepted:  A publication is defined as accepted if it has been finally accepted for publication by an editorial board or similar entity empowered to authorize publication and will appear in print or online in the future.
In press:  A publication is defined as in press if it has been accepted for publication and has been copy-edited, or otherwise made ready for publication at a date certain.
Submitted:  Submitted refers to a manuscript that has been submitted to a publisher for publication review.

Optional for your CV. In your promotion packet, roles of learners are noted. Graduate students, post-docs, residents, fellows & interns listed as authors should be identified using the key.
Senior/principal author(s) = Underline.
Self = bold
Fellow = f
Graduate Student = g
Other = &
Post-Doctoral Associate/Fellow = p
Resident = r

For your P&T packet. Order of publications:
a. Books, Sole Author (Title, Publisher, Place of Publication, Date, Inclusive Pages)
b. Books, Co-authored (Co-author(s), Title, Publisher, Place of Publication, Date, Inclusive Pages)
c. Books, Edited (Editor, Co-editor(s), Title, Publisher, Place of Publication, Date, Inclusive Pages)
d. Books, Contributor of Chapter(s) (Author, Co-author(s), Title of Book and Chapter, Publisher, Place of Publication, Date, Inclusive Pages)
e. Monographs (Author, Co-author(s), Title, Series of Volume, if applicable, Publisher, Place of Publication, Date, Inclusive Pages)
f. Refereed Publications (Author, Co-author(s), Title, Name of Journal or Publication, Volume, Date, Inclusive Pages)
g. Non-refereed Publications (Author, Co-author(s), Title, Name of Journal, Bulletin, Circular, or other Publication, Volume, Date, Inclusive Pages)
h. Bibliographies/Catalogs (Author, Co-author(s), Title, Publisher, Place of Publication, Date, Inclusive Pages)
i. Abstracts (Author, Co-author(s), Title, Name of Journal or Publication, Volume, Date, Inclusive Pages)
j. Reviews (Author, Co-author(s), Title and Author of Work Reviewed, Where Review was Published, Date, Inclusive Pages)
k. Miscellaneous (Author, Co-author(s), Title, Source of Publication, Date, Inclusive Pages)

This Document
Notes about Curriculum Vitae (CV)
CVs are not as strict as the Promotion and Tenure (P&T) packets. We strongly encourage you use the above template for your CV, but this document is to reveal Your Brand, this is to show the world your professional persona. Please keep that in mind when you make modifications, for example, if you wanted to change font, go with something like Georgia or Arial, not Comic Sans and Jokerman. 

[image: ]If a section doesn't apply to you, you can remove it. Keep in mind that section may be required for the P&T packet, where you would put an N/A for the nonapplicable sections. 

Formatting Defaults
The defaults for this document are:
· Font
· Calibri, Size 11
· Paragraph
· Single Spaced, Left Aligned
· Tabs (found under the Paragraph window) 
· Left Tab Stops at 0.25" and 0.50"
· Right Tab Stop set at 7.00"

Headings
Headings are shown in the Styles group on the Home tab. If you need to define a new heading, click in the paragraph and choose the heading. While these are simple formats – Bold, Italics, and Underline, using the actual headings will make your document easier to navigate. 

· Heading 1: Bold
· Heading 2: Italicized
· Heading 3: Underlined

Turn on the Navigation Pane from the View tab to see a list of the headings and help you move around the document. 

[image: ]

Clearing all formats
To clear a format from your text or paragraphs, select the area and click on the Normal style, or the Clear All Formatting button in the Font group of the Home tab. 

Inserting Text from another file
Word can sometimes feel wonky when you paste values from another file. Here are some things that might help.

· Paste Options – The shortcut key, Ctrl V, and the Paste button brings values in as they were copied. But if you click on the drop-down list under the Paste button, or use the right-click menu you will have other options: 
· [image: ]Keep Source Formatting
· Merge Formatting
· Insert as a Picture
· Keep Text Only

Which one to choose depends on the circumstance. Most of the time I use the Keep Text Only to cut down on any formats the text may be carrying with it. However, for something like the bibliography I don't want to lose all the bolds and underlines. In that case I would use the Merge Format to try to keep the basic formatting (like the bullets and underlines), but use my default font.

	Original
	Keep Source
	Merge Format
	Keep Text Only

	· Microsoft Word
· It's so Awesome!
	· Microsoft Word
· It's so Awesome!
	· Microsoft Word
· It's so Awesome!

	•	Microsoft Word
•	It's so Awesome!

	Bullets, strange font and sizes, underline, larger paragraph spacing
	Looks the same as the original
	Keeps the bullets and underline, but fixes the fonts and spacing
	Keeps the text, but all formatting. The symbols for the bullets came through, but this is not a bulleted list.



When you paste, if you don't like the result look for the clipboard icon to appear in the bottom right corner to change the paste option, or undo and try again. If it still feels awkward, use your Format Painter to help the text fall into place.


Format Painter
On the Home tab, in the Clipboard group is a Format Painter. This tool is your best friend in Word.

When the bullets, or numbers, or formats go "weird", click in a similar paragraph that looks "good", then turn on the Format Painter and click in the "weird" paragraph.

[image: ]This tool is especially useful for Bulleted and Numbered lists, but can be used for tabs, spacing, and varying fonts.
image3.png
Fle  Home Inset Design Layout References Malings  Review (RIS

=] [ outine ) z @@ uler Q [‘%ﬂ

Eontt = ] Gridines
ead | Print | Web Leaming  Vertical| Side Zoom 100%
lode Layout Layout Tools to Side. lavigation Pane k
Views Immersive Page Movement Show z
Navigation v 8

Search document

Headings  Pages  Results

Education and Training

Academic, Administrative & Clinical..
Professional Education & Experience
Military Service




image4.png
Fie [ et Design  layout References  Moilings  Review View Developer Help  Acobat Q) Tell mewhatyouwant o

B Cavitoay [ | K X -t 202 TN e P —

Paste B I U-aex.x A-¥-A-

o Format Pantes - | TNomnal | fNote TNumber.. Heading

Clipboard 5 Font 5 Paragraph 5 Styles




image5.png
Iy Paste Options:

[y =g vy




image6.png
Fie [ESUSM inet  Design  Layout

“D % cu Calibri (Body) ~|11 ~] 2
poste B I U-akx X
- ¥ Format = 8
Clipboard 5 Font
2 Format Painter (Ctrl=Shift-C, Ctrl+Shift+V)

Like the look of a particular selection? You
can apply that look to other content in the
document,

To get started:
1. Select content with the formatting you like
2. Click Format Painter

3. Select something else to automatically
3pply the formatting

FYI To apply the formatting in mutiple
places, double-click Format Painter.
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